
使用する前に

この章では、ASAの使用を開始する方法について説明します。

•コマンドラインインターフェイス（CLI）のコンソールへのアクセス（1ページ）
• FIPSモードの有効化（6ページ）
• ASDMアクセスの設定（7ページ）
• ASDMの起動（11ページ）
• ASDM動作のカスタマイズ（12ページ）
•工場出荷時のデフォルト設定（15ページ）
•設定の開始（31ページ）
• ASDMでのコマンドラインインターフェイスツールの使用（32ページ）
•接続の設定変更の適用（33ページ）

コマンドラインインターフェイス（CLI）のコンソールへ
のアクセス

ASDMアクセスの基本的な設定を、CLIを使用して行う必要がある場合があります。

初期設定を行うには、コンソールポートから直接 CLIにアクセスします。その後、管理アク
セスに従って Telnetまたは SSHを使用して、リモートアクセスを設定できます。システムが
すでにマルチコンテキストモードで動作している場合は、コンソールポートにアクセスする

とシステムの実行スペースに入ります。

コンソールポートに接続したときに、読み取れない文字が表示される場合は、ポートの設定を

確認してください。設定が正しい場合は、同じ設定を使用して別のデバイスでそのケーブルを

試します。ケーブルに問題がない場合は、コンソールポートのハードウェアを交換する必要が

ある可能性があります。別のワークステーションでの接続を試みることも検討してください。

ASA仮想のコンソールアクセスについては、ASA仮想のクイックスタートガイドを参照して
ください。

（注）
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ISA 3000コンソールへのアクセス
アプライアンスコンソールにアクセスするには、次の手順に従います。

手順

ステップ 1 付属のコンソールケーブルを使用してコンピュータをコンソールポートに接続します。ター
ミナルエミュレータを回線速度 9600ボー、データビット 8、パリティなし、ストップビット
1、フロー制御なしに設定して、コンソールに接続します。

コンソールケーブルの詳細については、ASAのハードウェアガイドを参照してください。

ステップ 2 Enterキーを押して、次のプロンプトが表示されることを確認します。

ciscoasa>

このプロンプトは、ユーザー EXECモードで作業していることを示します。ユーザー EXEC
モードでは、基本コマンドのみを使用できます。

ステップ 3 特権 EXECモードにアクセスします。

enable

enableコマンドを最初に入力したときに、パスワードを変更するように求められます。

例：

ciscoasa> enable
Password:
The enable password is not set. Please set it now.
Enter Password: ******
Repeat Password: ******
ciscoasa#

設定以外のすべてのコマンドは、特権EXECモードで使用できます。特権EXECモードからコ
ンフィギュレーションモードに入ることもできます。

特権モードを終了するには、disableコマンド、exitコマンド、または quitコマンドを入力し
ます。

ステップ 4 グローバルコンフィギュレーションモードにアクセスします。

configure terminal

例：

ciscoasa# configure terminal
ciscoasa(config)#
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グローバルコンフィギュレーションモードからASAの設定を開始できます。グローバルコン
フィギュレーションモードを終了するには、exitコマンド、quitコマンド、または endコマン
ドを入力します。

Firepower 1000および Cisco Secure Firewall 1200/3100/4200コンソールに
アクセスする

Firepower 1000および Cisco Secure Firewall 1200/3100/4200コンソールポートを使用して、ASA
CLIに接続します。ASA CLIから、トラブルシューティングのために Telnetを使用して FXOS
CLIに接続できます。

手順

ステップ 1 管理コンピュータをコンソールポートに接続します。ご使用のオペレーティングシステムに必
要なシリアルドライバを必ずインストールしてください。次のシリアル設定を使用します。

• 9600ボー

• 8データビット

•パリティなし

• 1ストップビット

ASACLIに接続します。デフォルトでは、コンソールアクセスに必要なユーザークレデンシャ
ルはありません。

ステップ 2 特権 EXECモードにアクセスします。

enable

enableコマンドを最初に入力したときに、パスワードを変更するように求められます。

例：

ciscoasa> enable
Password:
The enable password is not set. Please set it now.
Enter Password: ******
Repeat Password: ******
ciscoasa#

ASAで設定したイネーブルパスワードは、FXOS管理者のユーザーパスワードでもあり、ASA
の起動に失敗した場合は、FXOSフェールセーフモードに移行します。

設定以外のすべてのコマンドは、特権EXECモードで使用できます。特権EXECモードからコ
ンフィギュレーションモードに入ることもできます。
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特権 EXECモードを終了するには、disable、exit、または quitコマンドを入力します。

ステップ 3 グローバルコンフィギュレーションモードにアクセスします。

configure terminal

例：

ciscoasa# configure terminal
ciscoasa(config)#

グローバルコンフィギュレーションモードからASAの設定を開始できます。グローバルコン
フィギュレーションモードを終了するには、exit、quit、または endコマンドを入力します。

ステップ 4 （任意） FXOS CLIに接続します。

connect fxos [admin]

• admin：管理者レベルのアクセスを提供します。このオプションを指定しないと、ユーザー
のアクセス権は読み取り専用アクセスになります。管理者モードであっても、コンフィ

ギュレーションコマンドは使用できないことに注意してください。

ユーザーはクレデンシャルの入力を求められません。現在の ASAユーザー名が FXOSに渡さ
れるため、追加のログインは必要ありません。ASA CLIに戻るには、exitと入力するか、
Ctrl+Shift+6を押し、xと入力します。

FXOS内では、scope security/show audit-logsコマンドを使用してユーザーアクティビティを表
示できます。

例：

ciscoasa# connect fxos admin
Connecting to fxos.
Connected to fxos. Escape character sequence is 'CTRL-^X'.
firepower#
firepower# exit
Connection with FXOS terminated.
Type help or '?' for a list of available commands.
ciscoasa#

Firepower 4100/9300シャーシ上の ASAコンソールへのアクセス
初期設定の場合、Firepower 4100/9300シャーシスーパバイザに（コンソールポートに、ある
いは Telnetまたは SSHを使用してリモートで）接続してコマンドラインインターフェイスに
アクセスし、ASAセキュリティモジュールに接続します。

使用する前に

4

使用する前に

Firepower 4100/9300シャーシ上の ASAコンソールへのアクセス



手順

ステップ 1 Firepower 4100/9300シャーシスーパバイザCLI（コンソールまたはSSH）に接続し、次にASA
にセッション接続します。

connect module slot {console | telnet}

Telnet接続を使用する利点は、モジュールに同時に複数のセッションを設定でき、接続速度が
速くなることです。

初めてモジュールにアクセスするときは、FXOSモジュールのCLIにアクセスします。その後
ASAアプリケーションに接続する必要があります。

connect asa

例：

Firepower# connect module 1 console
Firepower-module1> connect asa

asa>

ステップ 2 最高の特権レベルである特権 EXECモードにアクセスします。

enable

enableコマンドを最初に入力したときに、パスワードを変更するように求められます。

例：

asa> enable
Password:
The enable password is not set. Please set it now.
Enter Password: ******
Repeat Password: ******
asa#

設定以外のすべてのコマンドは、特権EXECモードで使用できます。特権EXECモードからコ
ンフィギュレーションモードに入ることもできます。

特権モードを終了するには、disableコマンド、exitコマンド、または quitコマンドを入力し
ます。

ステップ 3 グローバルコンフィギュレーションモードを開始します。

configure terminal

例：

asa# configure terminal
asa(config)#
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グローバルコンフィギュレーションモードを終了するには、disable、exit、または quitコマ
ンドを入力します。

ステップ 4 Ctrl-a、dと入力し、アプリケーションコンソールを終了して FXOSモジュール CLIに移動し
ます。

トラブルシューティングのために FXOSモジュールの CLIを使用する場合があります。

ステップ 5 FXOS CLIのスーパバイザレベルに戻ります。

コンソールを終了します。

a) ~と入力

Telnetアプリケーションに切り替わります。

b) Telnetアプリケーションを終了するには、次を入力します。

telnet>quit

Telnetセッションを終了します。

a) Ctrl-], .と入力

FIPSモードの有効化
連邦情報処理標準（FIPS）は、米国およびカナダ政府の認証規格です。暗号化モジュールで順
守する必要がある要件が規定されています。Cisco ASAの特定のバージョンは、米国の国立標
準技術研究所（NIST）に従って、FIPS 140-3に準拠しています。

CiscoASAでFIPSを有効化することに加え、FIPSに準拠する暗号も構成する必要があります。

クラスタリングに対して FIPSを有効にすることはできません。

始める前に

• FIPSモードは、FIPS準拠のリリースだけでサポートされます。FIPSに準拠していないバー
ジョンをアップグレードする前に FIPSを無効にする必要があります。

FIPSに準拠しているリリースに関する情報とそれらの認定を確認するには、
https://www.cisco.com/c/en/us/solutions/industries/government/global-government-certifications/
fips-140.html?flt0_general-table0=asaを参照してください。

•フェールオーバーでは、両方のユニットが FIPSモードである必要があります。

手順

ステップ 1 Cisco ASAで FIPSを有効にします。
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fips enable

例：

ciscoasa(config)# fips enable
WARNING: FIPS mode change will not take effect until you save configuration and reboot
the device

FIPSが有効な場合、起動時に、FIPSPOSTが実行され次のコンソールメッセージが出力されま
す。

Copyright (c) 1996-2005 by Cisco Systems, Inc.
Restricted Rights Legend
Use, duplication, or disclosure by the Government is subject to restrictions as set forth
in subparagraph (c) of the Commercial Computer Software - Restricted Rights clause at
FAR sec. 52.227-19 and subparagraph (c) (1) (ii) of the Rights in Technical Data and
Computer Software clause at DFARS sec. 252.227-7013.

Cisco Systems, Inc.
170 West Tasman Drive
San Jose, California 95134-1706

....
Cryptochecksum (unchanged): 6c6d2f77 ef13898e 682c9f94 9c2d5ba9

INFO: FIPS Power-On Self-Test in process. Estimated completion in 90 seconds.
......................................................
INFO: FIPS Power-On Self-Test complete.
Type help or '?' for a list of available commands.
ciscoasa>

ステップ 2 構成を保存してリロードします。

write memory

reload

ステップ 3 （任意）電源投入時自己診断テスト（POST）を実行します。

fips self-test poweron

テストには、暗号化アルゴリズムテスト、ソフトウェア完全性テスト、および重要機能のテス

トがあります。

ASDMアクセスの設定
ここでは、デフォルト設定で ASDMにアクセスする方法、およびデフォルト設定がない場合
にアクセスを設定する方法について説明します。

ASDMアクセスの工場出荷時のデフォルト設定の使用
工場出荷時のデフォルトコンフィギュレーションでは、ASDM接続はデフォルトのネットワー
ク設定で事前設定されています。
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手順

次のインターフェイスおよびネットワーク設定を使用して ASDMに接続します。

•管理インターフェイスは、ご使用のモデルによって異なります。

• Firepower 1010、Cisco Secure Firewall 1210/1220：管理 1/1（192.168.45.1）、または内
部イーサネット 1/2～ 1/8（1010および 1210）または 1/10（1220）（192.168.1.1）。
管理ホストは 192.168.45.0/24ネットワークに限定され、内部ホストは 192.168.1.0/24
ネットワークに限定されます。

• Firepower 1100、Cisco Secure Firewall 3100/4200：内部イーサネット 1/2（192.168.1.1）
または管理 1/1（DHCPから）。内部ホストは 192.168.1.0/24ネットワークに限定され
ます。管理ホストは任意のネットワークからアクセスできます。

• Firepower 4100/9300：展開時に定義された管理タイプインターフェイスと IPアドレ
ス。管理ホストは任意のネットワークからアクセスできます。

• ASA仮想：管理 0/0（展開時に設定）。管理ホストは管理ネットワークに限定されま
す。

• ISA 3000：管理 1/1（192.168.1.1）。管理ホストは 192.168.1.0/24ネットワークに限定
されます。

（注）

マルチコンテキストモードに変更すると、上記のネットワーク設定を使用して管理コンテキ

ストから ASDMにアクセスできるようになります。

関連トピック

工場出荷時のデフォルト設定（15ページ）
マルチコンテキストモードの有効化または無効化

ASDMの起動（11ページ）

ASDMアクセスのカスタマイズ
次の条件に 1つ以上当てはまる場合は、この手順を使用します。

•工場出荷時のデフォルトコンフィギュレーションがない。

•トランスペアレントファイアウォールモードに変更したい。

•マルチコンテキストモードに変更したい。

シングルルーテッドモードの場合、ASDMに迅速かつ容易にアクセスするために、独自の管
理 IPアドレスを設定できるオプションを備えた工場出荷時のデフォルトコンフィギュレーショ
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ンを適用することを推奨します。この項に記載されている手順は、特別なニーズ（トランスペ

アレントモードやマルチコンテキストモードの設定など）がある場合や、他の設定を維持す

る必要がある場合にのみ使用してください。

ASAvの場合、導入時にトランスペアレントモードを設定できるため、この手順は、設定をク
リアする必要がある場合など、導入後に特に役立ちます。

（注）

手順

ステップ 1 コンソールポートで CLIにアクセスします。

ステップ 2 （オプション）トランスペアレントファイアウォールモードをイネーブルにします。

このコマンドは、設定をクリアします。

firewall transparent

ステップ 3 管理インターフェイスを設定します。

interface interface_id
nameif name
security-level level
no shutdown
ip address ip_address mask

例：

ciscoasa(config)# interface management 0/0
ciscoasa(config-if)# nameif management
ciscoasa(config-if)# security-level 100
ciscoasa(config-if)# no shutdown
ciscoasa(config-if)# ip address 192.168.1.1 255.255.255.0

security-levelは、1～ 100の数字です。100が最も安全です。

ステップ 4 （直接接続された管理ホスト用）管理ネットワークの DHCPプールを設定します。

dhcpd address ip_address-ip_address interface_name
dhcpd enable interface_name

例：

ciscoasa(config)# dhcpd address 192.168.1.2-192.168.1.254 management
ciscoasa(config)# dhcpd enable management

その範囲にインターフェイスアドレスが含まれていないことを確認します。

ステップ 5 （リモート管理ホスト用）管理ホストへのルートを設定します。
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route management_ifc management_host_ip mask gateway_ip 1

例：

ciscoasa(config)# route management 10.1.1.0 255.255.255.0 192.168.1.50 1

ステップ 6 ASDMの HTTPサーバーをイネーブルにします。

http server enable

ステップ 7 管理ホストの ASDMへのアクセスを許可します。

http ip_address mask interface_name

例：

ciscoasa(config)# http 192.168.1.0 255.255.255.0 management

ステップ 8 設定を保存します。

write memory

ステップ 9 （オプション）モードをマルチモードに設定します。

mode multiple

プロンプトが表示されたら、既存の設定を管理コンテキストに変換することを承認します。

ASAをリロードするよう求められます。

例

次の設定では、ファイアウォールモードがトランスペアレントモードに変換され、

Management 0/0インターフェイスが設定され、管理ホストに対してASDMがイネーブ
ルにされます。

firewall transparent
interface management 0/0

ip address 192.168.1.1 255.255.255.0
nameif management
security-level 100
no shutdown

dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management
http server enable
http 192.168.1.0 255.255.255.0 management

関連トピック

工場出荷時のデフォルト設定の復元（16ページ）
ファイアウォールモード（シングルモード）の設定
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ISA 3000コンソールへのアクセス（2ページ）
ASDMの起動（11ページ）

ASDMの起動
ASDM Launcherを使用して ASDMを起動します。ランチャは、Cisco ASAからWebブラウザ
を使用してダウンロードされるアプリケーションです。これを使用すると、任意の Cisco ASA
IPアドレスに接続できます。他の ASAに接続する場合、ランチャを再度ダウンロードする必
要はありません。

ASDMでは、管理のために別の Cisco ASA IPアドレスを選択できます。

ここでは、まず ASDMに接続する方法について説明します。次にランチャを使用して ASDM
を起動する方法について説明します。

ASDMはローカルの \Users\<user_id>\.asdmディレクトリ内にキャッシュ、ログ、設定などの
ファイルを保存し、Tempディレクトリ内にもセキュアクライアントプロファイルなどのファ
イルを保存します。

手順

ステップ 1 ASDMクライアントとして指定したコンピュータで次の URLを入力します。

https://asa_ip_address/admin

（注）

http://や IPアドレス（デフォルトは HTTP）ではなく、必ず https://を指定してください。
ASAは、HTTP要求を HTTPSに自動的に転送しません。

次のボタンを持つ ASDM起動ページが表示されます。

ASDM Launcherのインストール

ステップ 2 ランチャをダウンロードして、ASDMを起動するには、次の手順を実行します。

a) [ASDM Launcherのインストール（Install ASDM Launcher）]をクリックします。
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図 1 : ASDM Launcherのインストール

b) ユーザー名とパスワードのフィールドを空のままにし（新規インストールの場合）、[OK]
をクリックします。

HTTPS認証が設定されていない場合は、ユーザー名およびイネーブルパスワード（デフォ
ルトで空白）を入力しないで ASDMにアクセスできます。CLIで enableコマンドを最初
に入力したときに、パスワードを変更するように求められます。ASDMにログインしたと
きには、この動作は適用されません。空白のままにしないように、できるだけ早くイネー

ブルパスワードを変更することをお勧めします。ホスト名、ドメイン名、およびイネーブ

ルパスワードと Telnetパスワードの設定を参照してください。注：HTTPS認証をイネー
ブルにした場合、ユーザー名と関連付けられたパスワードを入力します。認証が有効でな

い場合でも、ログイン画面で（ユーザー名をブランクのままにしないで）ユーザー名とパ

スワードを入力すると、ASDMによってローカルデータベースで一致がチェックされま
す。

c) インストーラをコンピュータに保存して、インストーラを起動します。インストールが完
了すると、ASDM Launcherは自動起動します。

d) 管理 IPアドレス、および同じユーザー名とパスワード（新規インストールの場合は空白）
を入力し、[OK]をクリックします。

ASDM動作のカスタマイズ
アイデンティティ証明書をインストールしてASDMを正常に起動するだけでなく、ASDMヒー
プメモリを増大することもできるため、より大きいサイズのコンフィギュレーションを処理で

きます。
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ASDMのアイデンティティ証明書のインストール
Java 7 Update 51以降を使用する場合、ASDMランチャには信頼できる証明書が必要です。証
明書の要件は、自己署名付きの ID証明書をインストールすることによって簡単に満たすこと
ができます。

ASDMで使用するために Cisco ASAに自己署名された ID証明書をインストールし、Javaを使
用して証明書を登録するには、次のマニュアルを参照してください。

http://www.cisco.com/go/asdm-certificate

ASDMコンフィギュレーションメモリの増大
ASDMでサポートされる最大設定サイズは 512 KBです。このサイズを超えると、パフォーマ
ンスの問題が生じることがあります。たとえば、コンフィギュレーションのロード時には、完

了したコンフィギュレーションの割合がステータスダイアログボックスに表示されます。この

とき、サイズの大きいコンフィギュレーションでは、ASDMによってまだコンフィギュレー
ションの処理が行われていても、完了した割合の増分が停止し、操作が中断されているように

見えます。このような状況が発生した場合は、ASDMシステムヒープメモリの増大を検討す
ることを推奨します。メモリが枯渇していることを確認するには、Javaコンソールで
「java.lang.OutOfMemoryError」メッセージをモニターします。

さらに、可能であれば、未使用のオブジェクトを削除するなどして、構成サイズを減らすこと

をお勧めします。

Windowsでの ASDMコンフィギュレーションメモリの増大

ASDMヒープメモリサイズを増大するには、次の手順を実行して run.batファイルを編集しま
す。

手順

ステップ 1 ASDMインストールディレクトリ（たとえば、C:\Program Files (x86)\Cisco Systems\ASDM）に
移動します。

ステップ 2 任意のテキストエディタを使用して run.batファイルを編集します。

ステップ 3 「start javaw.exe」で始まる行で、「-Xmx」のプレフィックスが付いた引数を変更し、目的の
ヒープサイズを指定します。たとえば、768MBの場合は -Xmx768Mに変更し、1GBの場合は
-Xmx1Gに変更します。

非常に大規模な構成では、最大 2 GBのヒープサイズを指定する必要がある場合があります。

ステップ 4 run.batファイルを保存します。
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Mac OSでの ASDMコンフィギュレーションメモリの増大

ASDMヒープメモリサイズを増大するには、次の手順を実行して Info.plist ファイルを編集し
ます。

手順

ステップ 1 [Cisco ASDM-IDM]アイコンを右クリックし、[Show Package Contents]を選択します。

ステップ 2 [Contents]フォルダで、Info.plistファイルをダブルクリックします。開発者ツールをインストー
ルしている場合は、プロパティリストエディタで開きます。そうでない場合は、TextEditで開
きます。

ステップ 3 [Java] > [VMOptions]で、「-Xmx」のプレフィックスが付いた文字列を変更し、必要なヒープ
サイズを指定します。たとえば、768MBの場合は -Xmx768Mに変更し、1GBの場合は -Xmx1G
に変更します。

非常に大規模な構成では、最大 2 GBのヒープサイズを指定する必要がある場合があります。

ステップ 4 このファイルがロックされると、次のようなエラーが表示されます。

ステップ 5 [Unlock]をクリックし、ファイルを保存します。

[Unlock]ダイアログボックスが表示されない場合は、エディタを終了します。[CiscoASDM-IDM]
アイコンを右クリックし、[CopyCiscoASDM-IDM]を選択して、書き込み権限がある場所（デ
スクトップなど）に貼り付けます。その後、このコピーからヒープサイズを変更します。
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工場出荷時のデフォルト設定
工場出荷時のデフォルト設定とは、シスコが新しい ASAに適用したコンフィギュレーション
です。

• Firepower 1010：工場出荷時のデフォルト設定により、機能内部/外部設定が有効になりま
す。ASAは、管理インターフェイスまたは内部スイッチポートから ASDMを使用して管
理できます。

• Firepower 1100：工場出荷時のデフォルト設定により、機能内部/外部設定が有効になりま
す。ASAは、管理インターフェイスまたは内部インターフェイスから ASDMを使用して
管理できます。

• Cisco Secure Firewall 1210/1220：工場出荷時のデフォルト構成により、機能内部/外部構成
が有効になります。ASAは、管理インターフェイスまたは内部スイッチポートからASDM
を使用して管理できます。

• Secure Firewall 3100：工場出荷時のデフォルト設定により、機能内部/外部設定が有効にな
ります。ASAは、Management 1/1インターフェイスまたは内部インターフェイスから
ASDMを使用して管理できます。

• Secure Firewall 4200：工場出荷時のデフォルト設定により、機能内部/外部設定が有効にな
ります。ASAは、Management 1/1インターフェイスまたは内部インターフェイスから
ASDMを使用して管理できます。

• Firepower4100/9300シャーシ：ASAのスタンドアロンまたはクラスタを展開する場合、管
理用のインターフェイスは工場出荷時のデフォルト設定によって設定されるため、ASDM
を使用してこのインターフェイスに接続して設定を完了できます。

• ASA仮想：ハイパーバイザによっては、展開の一環として、展開設定（初期の仮想展開設
定）によって管理用のインターフェイスが設定されるため、ASDMを使用してこのイン
ターフェイスに接続して設定を完了できます。フェールオーバー IPアドレスも設定でき
ます。また、必要に応じて、「工場出荷時のデフォルト」コンフィギュレーションを適用

することもできます。

• ISA 3000：工場出荷時のデフォルト設定は、同じネットワーク上のすべての内部および外
部インターフェイスを使用した、ほぼ完全なトランスペアレントファイアウォールモー

ド設定です。ASDMを使用して管理インターフェイスに接続し、ネットワークの IPアド
レスを設定できます。ハードウェアバイパスは2つのインターフェイスペアに対して有効
になっていて。

アプライアンスの場合、工場出荷時のデフォルト設定は、工場出荷時のデフォルト設定がトラ

ンスペアレントモードでのみ使用可能な ISA 3000を除き、ルーテッドファイアウォールモー
ドとシングルコンテキストモードのみで使用できます。ASA仮想および Firepower 4100/9300
シャーシの場合、展開時にトランスペアレントモードまたはルーテッドモードを選択できま

す。
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イメージファイルと（隠された）デフォルトコンフィギュレーションに加え、log/、
crypto_archive/、および coredumpinfo/coredump.cfgがフラッシュメモリ内の標準のフォルダと
ファイルです。フラッシュメモリ内で、これらのファイルの日付は、イメージファイルの日

付と一致しない場合があります。これらのファイルは、トラブルシューティングに役立ちます

が、障害が発生したことを示すわけではありません。

（注）

工場出荷時のデフォルト設定の復元

この項では、工場出荷時のデフォルトコンフィギュレーションを復元する方法について説明し

ます。CLIおよび ASDMの両方の手順が提供されています。ASA仮想では、この手順を実行
することで展開設定が消去され、次の設定が適用されます。

interface management 0/0
ip address 192.168.1.1 255.255.255.0
nameif management
security-level 100
no shutdown

!
asdm logging informational
asdm history enable
!
http server enable
http 192.168.1.0 255.255.255.0 management
!
dhcpd address 192.168.1.2-192.168.1.254 management
dhcpd enable management

Firepower 4100/9300では、工場出荷時のデフォルト設定を復元すると単に設定が消去されるだ
けです。デフォルト設定を復元するには、スーパバイザから ASAをもう一度展開する必要が
あります。

（注）

始める前に

この機能は、ISA3000を除き、ルーテッドファイアウォールモードでのみ使用できます（ISA
3000では、このコマンドはトランスペアレントモードでのみサポートされます）。さらに、こ
の機能はシングルコンテキストモードでのみ使用できます。コンフィギュレーションがクリア

されたASAには、この機能を使用して自動的に設定する定義済みコンテキストがありません。

手順

ステップ 1 工場出荷時のデフォルトコンフィギュレーションを復元します。

configure factory-default [ip_address [mask]]
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例：

ciscoasa(config)# configure factory-default 10.1.1.1 255.255.255.0

ip_addressを指定する場合は、デフォルトの IPアドレスを使用する代わりに、お使いのモデル
に応じて、内部または管理インターフェイスの IPアドレスを設定します。ip_addressオプショ
ンで設定されているインターフェイスについては、次のモデルのガイドラインを参照してくだ

さい。

• Firepower 1010：管理インターフェイスの IPアドレスを設定します。

• Firepower 1100：内部インターフェイスの IPアドレスを設定します。

• Cisco Secure Firewall 1210/1220：管理インターフェイスの IPアドレスを設定します。

• Secure Firewall 3100：内部インターフェイスの IPアドレスを設定します。

• Secure Firewall 4200：内部インターフェイスの IPアドレスを設定します。

• Firepower 4100/9300：効果はありません。

• ASA仮想：管理インターフェイスの IPアドレスを設定します。

• ISA 3000：管理インターフェイスの IPアドレスを設定します。

httpコマンドでは、ユーザーが指定するサブネットが使用されます。同様に、dhcpd address
コマンドの範囲は、指定した IPアドレスよりも大きい使用可能なすべてのアドレスで構成さ
れます。たとえば、サブネットマスク 255.255.255.0で 10.5.6.78を指定した場合、DHCPアド
レスの範囲は 10.5.6.79～ 10.5.6.254になります。

Firepower 1000、および Cisco Secure Firewall 1200、3100、4200、6100の場合、このコマンド
は、残りの設定とともに boot systemコマンドが存在する場合は、そのコマンドをクリアしま
す。この設定変更は、ブートアップ時のイメージには影響を与えず、現在ロードされているイ

メージが引き続き使用されます。

その他すべてのモデルの場合：このコマンドは、残りの設定とともに boot systemコマンドを
クリアします（存在する場合）。boot systemコマンドを使用すると、特定のイメージから起
動できます。出荷時の設定に戻した後、次回 ASAをリロードすると、内部フラッシュメモリ
の最初のイメージからブートします。内部フラッシュメモリにイメージがない場合、ASAは
ブートしません。

例：

docs-bxb-asa3(config)# configure factory-default 10.86.203.151 255.255.254.0
Based on the management IP address and mask, the DHCP address
pool size is reduced to 103 from the platform limit 256

WARNING: The boot system configuration will be cleared.
The first image found in disk0:/ will be used to boot the
system on the next reload.
Verify there is a valid image on disk0:/ or the system will
not boot.

Begin to apply factory-default configuration:
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Clear all configuration
WARNING: The new maximum-session limit will take effect after the running-config is saved
and the system boots next time. Command accepted
WARNING: Local user database is empty and there are still 'aaa' commands for 'LOCAL'.
Executing command: interface management0/0
Executing command: nameif management
INFO: Security level for "management" set to 0 by default.
Executing command: ip address 10.86.203.151 255.255.254.0
Executing command: security-level 100
Executing command: no shutdown
Executing command: exit
Executing command: http server enable
Executing command: http 10.86.202.0 255.255.254.0 management
Executing command: dhcpd address 10.86.203.152-10.86.203.254 management
Executing command: dhcpd enable management
Executing command: logging asdm informational
Factory-default configuration is completed
ciscoasa(config)#

ステップ 2 デフォルトコンフィギュレーションをフラッシュメモリに保存します。

write memory

このコマンドでは、事前に boot configコマンドを設定して、別の場所を設定していた場合で
も、実行コンフィギュレーションはスタートアップコンフィギュレーションのデフォルトの場

所に保存されます。コンフィギュレーションがクリアされると、このパスもクリアされます。

ステップ 3 （ASDMでの手順。）メイン ASDMアプリケーションウィンドウで、次を実行します。

a) [File] > [Reset Device to the Factory Default Configuration]の順に選択します。

[Reset Device to the Default Configuration]ダイアログボックスが表示されます。

b) （オプション）デフォルトアドレスを使用する代わりに、管理または内部インターフェイ
スの管理 IPアドレスを入力します。

モデルごとに設定されているインターフェイス IPの詳細については、前述の CLI手順を
参照してください。

c) （オプション）ドロップダウンリストから [Management Subnet Mask]を選択します。
d) [OK]をクリックします。

確認用のダイアログボックスが表示されます。

（注）

Firepower 1000、およびCisco Secure Firewall 1200、3100、4200の場合：このコマンドは、
残りの設定とともにブートイメージの場所をクリアします（存在する場合）。この設定変

更は、ブートアップ時のイメージには影響を与えず、現在ロードされているイメージが引

き続き使用されます。

その他すべてのモデルの場合：この操作により、残りの設定とともにブートイメージの場

所もクリアされます（存在する場合）。[Configuration] > [Device Management] > [System
Image/Configuration] > [Boot Image/Configuration]ペインでは、外部メモリ上のイメージを含
む、特定のイメージからブートできます。出荷時の設定に戻した後、次回 ASAをリロー
ドすると、内部フラッシュメモリの最初のイメージからブートします。内部フラッシュメ

モリにイメージがない場合、ASAはブートしません。
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e) [Yes]をクリックします。
f) デフォルト設定を復元したら、この設定を内部フラッシュメモリに保存します。[File] >

[Save Running Configuration to Flash]を選択します。

このオプションを選択すると、以前に別の場所を設定している場合でも、実行コンフィ

ギュレーションがスタートアップコンフィギュレーションのデフォルトの場所に保存され

ます。コンフィギュレーションをクリアした場合は、このパスもクリアされています。

ASA仮想導入設定の復元
この項では、ASA仮想の導入（0日）設定を復元する方法について説明します。

手順

ステップ 1 フェールオーバーを行うために、スタンバイ装置の電源を切ります。

スタンバイユニットがアクティブになることを防ぐために、電源をオフにする必要がありま

す。電源を入れたままにした場合、アクティブ装置の設定を消去すると、スタンバイ装置がア

クティブになります。以前のアクティブユニットをリロードし、フェールオーバーリンクを

介して再接続すると、古い設定は新しいアクティブユニットから同期し、必要な導入コンフィ

ギュレーションが消去されます。

ステップ 2 リロード後に導入設定を復元します。フェールオーバーを行うために、アクティブ装置で次の
コマンドを入力します。

write erase

（注）

ASA仮想が現在の実行イメージをブートするため、元のブートイメージには戻りません。元
のブートイメージを使用するには、boot imageコマンドを参照してください。

コンフィギュレーションは保存しないでください。

ステップ 3 ASA仮想をリロードし、導入設定をロードします。

reload

ステップ 4 フェールオーバーを行うために、スタンバイ装置の電源を投入します。

アクティブ装置のリロード後、スタンバイ装置の電源を投入します。導入設定がスタンバイ装

置と同期されます。
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Firepower 1010のデフォルト設定
Firepower 1010の工場出荷時のデフォルト設定は、次のとおりです。

•ハードウェアスイッチ：イーサネット 1/2～ 1/8は VLAN 1に属しています。

•内部から外部へのトラフィックフロー：イーサネット 1/1（外部）、VLAN 1（内部）

•管理：管理 1/1（管理）、IPアドレス：192.168.45.1

• DHCPの外部 IPアドレス、内部 IPアドレス：192.168.1.1

•内部インターフェイスの DHCPサーバー、管理インターフェイス

•外部 DHCPからのデフォルトルート

• ASDMアクセス：管理ホストと内部ホストに許可されます。管理ホストは 192.168.45.0/24
ネットワークに限定され、内部ホストは 192.168.1.0/24ネットワークに限定されます。

• NAT：内部から外部へのすべてのトラフィック用のインターフェイス PAT。

• DNSサーバー：OpenDNSサーバーはあらかじめ構成されています。

このコンフィギュレーションは次のコマンドで構成されています。

interface Vlan1
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown
!
interface Management1/1
managment-only
nameif management
no shutdown
security-level 100
ip address 192.168.45.1 255.255.255.0
!
interface Ethernet1/1
nameif outside
ip address dhcp setroute
no shutdown
!
interface Ethernet1/2
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
interface Ethernet1/3
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
interface Ethernet1/4
no shutdown
switchport
switchport mode access
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switchport access vlan 1
!
interface Ethernet1/5
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
interface Ethernet1/6
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
interface Ethernet1/7
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
interface Ethernet1/8
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
object network obj_any

subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface

!
dhcpd auto_config outside
dhcpd address 192.168.1.20-192.168.1.254 inside
dhcpd address 192.168.45.10-192.168.45.12 management
dhcpd enable inside
dhcpd enable management
!
http server enable
http 192.168.45.0 255.255.255.0 management
http 192.168.1.0 255.255.255.0 inside
!
dns domain-lookup outside
dns server-group DefaultDNS

name-server 208.67.222.222 outside
name-server 208.67.220.220 outside

!

Firepower 1100のデフォルト設定
Firepower 1100の工場出荷時のデフォルト設定は、次のとおりです。

•内部から外部へのトラフィックフロー：Ethernet 1/1（外部）、Ethernet 1/2（内部）

• DHCPの外部 IPアドレス、内部 IPアドレス：192.168.1.1

•管理：Management 1/1（管理）、DHCPからの IPアドレス

•内部インターフェイスの DHCPサーバー

•外部 DHCP、管理 DHCPからのデフォルトルート
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• ASDMアクセス：管理ホストと内部ホストに許可されます。内部ホストは 192.168.1.0/24
ネットワークに限定されます。

• NAT：内部から外部へのすべてのトラフィック用のインターフェイス PAT。

• DNSサーバー：OpenDNSサーバーはあらかじめ構成されています。

このコンフィギュレーションは次のコマンドで構成されています。

interface Management1/1
management-only
nameif management
security-level 100
ip address dhcp setroute
no shutdown

!
interface Ethernet1/1
nameif outside
security-level 0
ip address dhcp setroute
no shutdown

!
interface Ethernet1/2
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown

!
object network obj_any
subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface

!
http server enable
http 0.0.0.0 0.0.0.0 management
http 192.168.1.0 255.255.255.0 inside
!
dhcpd auto_config outside
dhcpd address 192.168.1.20-192.168.1.254 inside
dhcpd enable inside
!
dns domain-lookup outside
dns server-group DefaultDNS

name-server 208.67.222.222 outside
name-server 208.67.220.220 outside

!

Cisco Secure Firewall 1210/1220のデフォルト設定
Cisco Secure Firewall 1210/1220の工場出荷時のデフォルト設定は、次のとおりです。

•ハードウェアスイッチ：イーサネット1/2～1/8（1210）または1/2～1/10（1220）はVLAN
1に属しています

•内部から外部へのトラフィックフロー：イーサネット 1/1（外部）、VLAN 1（内部）

•管理：管理 1/1（管理）、IPアドレス：192.168.45.1
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• DHCPの外部 IPアドレス、内部 IPアドレス：192.168.1.1

•内部インターフェイスの DHCPサーバー、管理インターフェイス

•外部 DHCPからのデフォルトルート

• ASDMアクセス：管理ホストと内部ホストに許可されます。管理ホストは 192.168.45.0/24
ネットワークに限定され、内部ホストは 192.168.1.0/24ネットワークに限定されます。

• NAT：内部から外部へのすべてのトラフィック用のインターフェイス PAT。

• DNSサーバー：OpenDNSサーバーはあらかじめ構成されています。

このコンフィギュレーションは次のコマンドで構成されています。

interface Vlan1
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown
!
interface Management1/1
managment-only
nameif management
no shutdown
security-level 100
ip address 192.168.45.1 255.255.255.0
!
interface Ethernet1/1
nameif outside
ip address dhcp setroute
no shutdown
!
interface Ethernet1/2
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
interface Ethernet1/3
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
interface Ethernet1/4
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
interface Ethernet1/5
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
interface Ethernet1/6
no shutdown
switchport
switchport mode access
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switchport access vlan 1
!
interface Ethernet1/7
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
interface Ethernet1/8
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
! 1220
interface Ethernet1/9
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
! 1220
interface Ethernet1/10
no shutdown
switchport
switchport mode access
switchport access vlan 1
!
object network obj_any

subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface

!
dhcpd auto_config outside
dhcpd address 192.168.1.20-192.168.1.254 inside
dhcpd address 192.168.45.10-192.168.45.12 management
dhcpd enable inside
dhcpd enable management
!
http server enable
http 192.168.45.0 255.255.255.0 management
http 192.168.1.0 255.255.255.0 inside
!
dns domain-lookup outside
dns server-group DefaultDNS

name-server 208.67.222.222 outside
name-server 208.67.220.220 outside

!

Cisco Secure Firewall 3100デフォルト設定
Cisco Secure Firewall 3100の工場出荷時のデフォルト設定は、次のとおりです。

•内部から外部へのトラフィックフロー：Ethernet 1/1（外部）、Ethernet 1/2（内部）

• DHCPの外部 IPアドレス、内部 IPアドレス：192.168.1.1

•管理：Management 1/1（管理）、DHCPからの IPアドレス

•内部インターフェイスの DHCPサーバー
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•外部 DHCP、管理 DHCPからのデフォルトルート

• ASDMアクセス：管理ホストと内部ホストに許可されます。内部ホストは 192.168.1.0/24
ネットワークに限定されます。

• NAT：内部から外部へのすべてのトラフィック用のインターフェイス PAT。

• DNSサーバー：OpenDNSサーバーはあらかじめ構成されています。

このコンフィギュレーションは次のコマンドで構成されています。

interface Management1/1
management-only
nameif management
security-level 100
ip address dhcp setroute
no shutdown

!
interface Ethernet1/1
nameif outside
security-level 0
ip address dhcp setroute
no shutdown

!
interface Ethernet1/2
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown

!
object network obj_any
subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface

!
http server enable
http 0.0.0.0 0.0.0.0 management
http 192.168.1.0 255.255.255.0 inside
!
dhcpd auto_config outside
dhcpd address 192.168.1.20-192.168.1.254 inside
dhcpd enable inside
!
dns domain-lookup outside
dns server-group DefaultDNS

name-server 208.67.222.222 outside
name-server 208.67.220.220 outside

!

Cisco Secure Firewall 4200のデフォルト設定
Cisco Secure Firewall 4200の工場出荷時のデフォルト設定は、次のとおりです。

•内部から外部へのトラフィックフロー：Ethernet 1/1（外部）、Ethernet 1/2（内部）

• DHCPの外部 IPアドレス、内部 IPアドレス：192.168.1.1

•管理：Management 1/1（管理）、DHCPからの IPアドレス
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•内部インターフェイスの DHCPサーバー

•外部 DHCP、管理 DHCPからのデフォルトルート

• ASDMアクセス：管理ホストと内部ホストに許可されます。内部ホストは 192.168.1.0/24
ネットワークに限定されます。

• NAT：内部から外部へのすべてのトラフィック用のインターフェイス PAT。

• DNSサーバー：OpenDNSサーバーはあらかじめ構成されています。

このコンフィギュレーションは次のコマンドで構成されています。

interface Management1/1
management-only
nameif management
security-level 100
ip address dhcp setroute
no shutdown

!
interface Ethernet1/1
nameif outside
security-level 0
ip address dhcp setroute
no shutdown

!
interface Ethernet1/2
nameif inside
security-level 100
ip address 192.168.1.1 255.255.255.0
no shutdown

!
object network obj_any
subnet 0.0.0.0 0.0.0.0
nat (any,outside) dynamic interface

!
http server enable
http 0.0.0.0 0.0.0.0 management
http 192.168.1.0 255.255.255.0 inside
!
dhcpd auto_config outside
dhcpd address 192.168.1.20-192.168.1.254 inside
dhcpd enable inside
!
dns domain-lookup outside
dns server-group DefaultDNS

name-server 208.67.222.222 outside
name-server 208.67.220.220 outside

!

Firepower 4100/9300シャーシデフォルト設定
Firepower 4100/9300シャーシ上に ASAを展開した場合、ASDMを使用して管理インターフェ
イスへの接続が可能になる多くのパラメータを事前設定できます。一般的な構成には次の設定

があります。

•管理インターフェイス：
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• Firepower 4100/9300シャーシスーパバイザ上で定義された任意の管理タイプインター
フェイス

•名前は「management」

•任意の IPアドレス

•セキュリティレベル 0

•管理専用

•管理インターフェイス内のデファルトルート

• ASDMアクセス：すべてのホストが許可されます。

スタンドアロンユニットの設定は、次のコマンドで構成されます。クラスタユニットの追加

の設定については、ASAクラスタの作成を参照してください。

interface <management_ifc>
management-only
ip address <ip_address> <mask>
ipv6 address <ipv6_address>
ipv6 enable
nameif management
security-level 0
no shutdown

!
http server enable
http 0.0.0.0 0.0.0.0 management
http ::/0 management
!
route management 0.0.0.0 0.0.0.0 <gateway_ip> 1
ipv6 route management ::/0 <gateway_ipv6>

ISA 3000のデフォルト設定
ISA 3000の工場出荷時のデフォルト設定は、次のとおりです。

•トランスペアレントファイアウォールモード：トランスペアレントファイアウォールは、
「Bump InTheWire」または「ステルスファイアウォール」のように動作するレイヤ2ファ
イアウォールであり、接続されたデバイスへのルータホップとしては認識されません。

• 1ブリッジ仮想インターフェイス：すべてのメンバーインターフェイスは同じネットワー
ク内に存在しています（IPアドレスは事前設定されていません。ネットワークと一致する
ように設定する必要があります）：GigabitEthernet 1/1（outside1）、GigabitEthernet 1/2
（inside1）、GigabitEthernet 1/3（outside2）、GigabitEthernet 1/4（inside2）

•すべての内部および外部インターフェイスは相互通信できます。

•管理 1/1インターフェイス：ASDMアクセスの 192.168.1.1/24。

•管理上のクライアントに対する DHCP。
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• ASDMアクセス：管理ホストに許可されます。

•ハードウェアバイパスは、次のインターフェイスペアで有効になっています。GigabitEthernet
1/1および 1/2。GigabitEthernet 1/3および 1/4

ISA 3000への電源が切断され、ハードウェアバイパスモードに
移行すると、通信できるのは上記のインターフェイスペアのみに

なります。inside1と inside2および outside1と outside2は通信でき
なくなります。これらのインターフェイス間の既存の接続がすべ

て失われます。電源が再投入されると、ASAがフローを引き継ぐ
ため、接続が短時間中断されます。

（注）

このコンフィギュレーションは次のコマンドで構成されています。

firewall transparent

interface GigabitEthernet1/1
bridge-group 1
nameif outside1
security-level 0
no shutdown

interface GigabitEthernet1/2
bridge-group 1
nameif inside1
security-level 100
no shutdown

interface GigabitEthernet1/3
bridge-group 1
nameif outside2
security-level 0
no shutdown

interface GigabitEthernet1/4
bridge-group 1
nameif inside2
security-level 100
no shutdown

interface Management1/1
management-only
no shutdown
nameif management
security-level 100
ip address 192.168.1.1 255.255.255.0

interface BVI1
no ip address

access-list allowAll extended permit ip any any
access-group allowAll in interface outside1
access-group allowAll in interface outside2

same-security-traffic permit inter-interface

hardware-bypass GigabitEthernet 1/1-1/2
hardware-bypass GigabitEthernet 1/3-1/4

http server enable
http 192.168.1.0 255.255.255.0 management
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dhcpd address 192.168.1.5-192.168.1.254 management
dhcpd enable management

ASA仮想による展開の設定
ASA仮想を導入すると、ASDMを使用して、Management 0/0インターフェイスへの接続を可
能にする多数のパラメータをプリセットできます。一般的な構成には次の設定があります。

•ルーテッドファイアウォールモードまたはトランスペアレントファイアウォールモード

• Management 0/0インターフェイス：

•名前は「management」

• IPアドレスまたは DHCP

•セキュリティレベル 0

•管理ホスト IPアドレスのスタティックルート（管理サブネット上にない場合）

• HTTPサーバーの有効または無効

•管理ホスト IPアドレス用の HTTPアクセス

•（オプション）GigabitEthernet0/8用のフェールオーバーリンク IPアドレス、Management0/0
のスタンバイ IPアドレス

• DNSサーバー

•スマートライセンス IDトークン

•スマートライセンスのスループットレベルおよびEssentials機能階層

• Smart Transport URL（https://smartreceiver.cisco.com/licservice/license）およびポート 80。

•（オプション）Smart Transportプロキシ URLおよびポート

•（オプション）SSH管理設定：

•クライアント IPアドレス

•ローカルユーザー名とパスワード

•ローカルデータベースを使用する SSHに必要な認証

•（オプション）REST APIの有効または無効
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Cisco Licensing AuthorityにASA仮想を正常に登録するには、ASA仮想にインターネットアク
セスが必要です。インターネットに接続してライセンス登録を完了させるには、導入後に追加

の設定が必要になることがあります。

（注）

スタンドアロンユニットについては、次の設定例を参照してください。

interface Management0/0
nameif management
security-level 0
ip address ip_address

no shutdown
http server enable
http managemment_host_IP mask management
route management management_host_IP mask gateway_ip 1
dns server-group DefaultDNS
name-server ip_address

call-home
http-proxy ip_address port port

license smart
feature tier standard
throughput level {100M | 1G | 2G}
license smart register idtoken id_token

aaa authentication ssh console LOCAL
username username password password
ssh source_IP_address mask management
rest-api image boot:/path
rest-api agent

Essentialsライセンスは、以前は「標準」ライセンスと呼ばれていました。（注）

フェールオーバーペアのプライマリユニットについては、次の設定例を参照してください。

nameif management
security-level 0
ip address ip_address standby standby_ip

no shutdown
route management management_host_IP mask gateway_ip 1
http server enable
http managemment_host_IP mask management
dns server-group DefaultDNS
name-server ip_address

call-home
http-proxy ip_address port port

license smart
feature tier standard
throughput level {100M | 1G | 2G}
license smart register idtoken id_token

aaa authentication ssh console LOCAL
username username password password
ssh source_IP_address mask management
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rest-api image boot:/path
rest-api agent
failover
failover lan unit primary
failover lan interface fover gigabitethernet0/8
failover link fover gigabitethernet0/8
failover interface ip fover primary_ip mask standby standby_ip

設定の開始
ASAを設定してモニターするには、次の手順を実行します。

ASDMでは、最大 512 KBの設定をサポートしています。このサイズを超えると、パフォーマ
ンスの問題が生じることがあります。ASDMコンフィギュレーションメモリの増大（13ペー
ジ）を参照してください。

（注）

手順

ステップ 1 Startup Wizardを使用して初期設定を行うには、[Wizards] > [Startup Wizard]を選択します。

ステップ 2 IPsec VPNWizardを使用して IPsec VPN接続を設定するには、[Wizards] > [IPsecVPNWizard]を
選択して、表示される各画面で設定を行います。

ステップ 3 SSL VPNWizardを使用して SSL VPN接続を設定するには、[Wizards] > [SSL VPNWizard]を選
択して、表示される各画面で設定を行います。

ステップ 4 高可用性とスケーラビリティに関する設定値を設定するには、[Wizards] > [High Availability and
Scalability Wizard]を選択します。

ステップ 5 PacketCaptureWizardを使用してパケットキャプチャを設定するには、[Wizards] > [PacketCapture
Wizard]を選択します。

ステップ 6 ASDM GUIで使用できるさまざまな色とスタイルを表示するには、[View] > [Office Look and
Feel]を選択します。

ステップ 7 機能を設定するには、ツールバーの [Configuration]ボタンをクリックし、いずれかの機能ボタ
ンをクリックして、関連する設定ペインを表示します。

（注）

[Configuration]画面が空白の場合は、ツールバーで [Refresh]をクリックして、画面のコンテン
ツを表示します。

ステップ 8 ASAをモニターするには、ツールバーの [Monitoring]ボタンをクリックし、機能ボタンをク
リックして、関連するモニタリングペインを表示します。
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ASDMでのコマンドラインインターフェイスツールの使
用

この項では、ASDMを使用してコマンドを入力する方法およびCLIの使用方法について説明し
ます。

コマンドラインインターフェイスツールの使用

この機能には、コマンドを ASAに送信して結果を表示する、テキストベースのツールが用意
されています。

CLIツールによって入力可能なコマンドは、ユーザー権限によって異なります。メインASDM
アプリケーションウィンドウの下部にあるステータスバーの権限レベルを見て、CLI特権コマ
ンドを実行するために必要な特権があるかどうかを確認してください。

始める前に

• ASDMの CLIツールから入力するコマンドは、ASAの接続ターミナルから入力するコマ
ンドと動作が異なる場合があります。

•コマンドエラー：誤った入力コマンドによってエラーが発生した場合、その誤ったコマン
ドはスキップされ、その他のコマンドは処理されます。[Response]領域には、他の関連情
報とともに、エラーが発生したかどうかについての情報を示すメッセージが表示されま

す。

•インタラクティブコマンド：インタラクティブコマンドは、CLIツールではサポートさ
れていません。これらのコマンドをASDMで使用するには、次のコマンドに示すように、
noconfirmキーワード（使用可能な場合）を使用します。

crypto key generate rsa modulus 1024 noconfirm

•他の管理者との競合を回避：複数の管理ユーザーが ASAの実行コンフィギュレーション
をアップデートできます。ASDMのCLIツールでコンフィギュレーションを変更する場合
は、アクティブな管理セッションが他にないことを事前に確認してください。複数のユー

ザーが同時に ASAを設定した場合、最新の変更が有効になります。

同じASAで現在アクティブな他の管理セッションを表示するには、[Monitoring]>[Properties]
> [Device Access]の順に選択します。

手順

ステップ 1 メイン ASDMアプリケーションウィンドウで、[Tools] > [Command Line Interface]の順に選
択します。
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[Command Line Interface]ダイアログボックスが表示されます。

ステップ 2 必要なコマンドのタイプ（1行または複数行）を選択し、ドロップダウンリストからコマンド
を選択するか、または表示されたフィールドにコマンドを入力します。

ステップ 3 [Send]をクリックしてコマンドを実行します。

ステップ 4 新しいコマンドを入力するには、[ClearResponse]をクリックしてから、実行する別のコマンド
を選択（または入力）します。

ステップ 5 この機能の状況依存ヘルプを表示するには、[Enable context-sensitive help (?)]チェックボックス
をオンにします。文脈依存ヘルプをディセーブルにするには、このチェックボックスをオフに

します。

ステップ 6 設定を変更した場合は、[Command Line Interface]ダイアログボックスを閉じた後に、[Refresh]
をクリックして ASDMでの変更内容を表示します。

ASDMによって無視されるコマンドのデバイス上での表示
この機能により、ASDMがサポートしていないコマンドの一覧を表示できます。通常 ASDM
は、これらのコマンドを無視します。ASDMは、実行コンフィギュレーションのこれらのコマ
ンドを変更、削除することはありません。詳細については、「サポートされていないコマン

ド」を参照してください。

手順

ステップ 1 メイン ASDMアプリケーションウィンドウで、[Tools] > [Show Commands Ignored by ASDM
on Device]の順に選択します。

ステップ 2 完了したら、[OK]をクリックします。

接続の設定変更の適用
コンフィギュレーションに対してセキュリティポリシーの変更を加えた場合は、すべての新し

い接続で新しいセキュリティポリシーが使用されます。既存の接続では、その接続が確立され

た時点で設定されていたポリシーの使用が続行されます。古い接続に対する showコマンドの
出力は古いコンフィギュレーションを反映しており、場合によっては古い接続に関するデータ

が含まれないことがあります。

たとえば、インターフェイスから QoS service-policyを削除し、修正バージョンを再度追加す
る場合、show service-policyコマンドには、新しいサービスポリシーと一致する新規接続と関
連付けられている QoSカウンタのみ表示されます。古いポリシーの既存の接続はコマンド出
力には表示されません。
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すべての接続が新しいポリシーを確実に使用するように、現在の接続を解除し、新しいポリ

シーを使用して再度接続できるようにします。

接続を解除するには、次のコマンドを入力します。

• clear conn [all] [protocol {tcp | udp}] [address src_ip [-src_ip] [netmask mask]] [port src_port
[-src_port]] [address dest_ip [-dest_ip] [netmask mask]] [port dest_port [-dest_port]]

このコマンドは、すべての状態の接続を終了します。現在のすべての接続を表示するに

は、show connコマンドを参照してください。

引数を指定しないと、このコマンドはすべての through-the-box接続をクリアします。
to-the-box接続もクリアするには（現在の管理セッションを含む）、allキーワードを使用
します。送信元 IPアドレス、宛先 IPアドレス、ポート、プロトコルに基づいて特定の接
続をクリアするには、必要なオプションを指定できます。

使用する前に

34

使用する前に

接続の設定変更の適用



翻訳について
このドキュメントは、米国シスコ発行ドキュメントの参考和訳です。リンク情報につきましては
、日本語版掲載時点で、英語版にアップデートがあり、リンク先のページが移動/変更されている
場合がありますことをご了承ください。あくまでも参考和訳となりますので、正式な内容につい
ては米国サイトのドキュメントを参照ください。



翻訳について
このドキュメントは、米国シスコ発行ドキュメントの参考和訳です。リンク情報につきましては
、日本語版掲載時点で、英語版にアップデートがあり、リンク先のページが移動/変更されている
場合がありますことをご了承ください。あくまでも参考和訳となりますので、正式な内容につい
ては米国サイトのドキュメントを参照ください。


	使用する前に
	コマンドライン インターフェイス（CLI）のコンソールへのアクセス
	ISA 3000 コンソールへのアクセス
	Firepower 1000および Cisco Secure Firewall 1200/3100/4200 コンソールにアクセスする
	Firepower 4100/9300 シャーシ 上の ASA コンソールへのアクセス

	FIPS モードの有効化
	ASDM アクセスの設定
	ASDM アクセスの工場出荷時のデフォルト設定の使用
	ASDM アクセスのカスタマイズ

	ASDM の起動
	ASDM 動作のカスタマイズ
	ASDM のアイデンティティ証明書のインストール
	ASDM コンフィギュレーションメモリの増大
	Windows での ASDM コンフィギュレーションメモリの増大
	Mac OS での ASDM コンフィギュレーションメモリの増大


	工場出荷時のデフォルト設定
	工場出荷時のデフォルト設定の復元
	ASA 仮想 導入設定の復元
	Firepower 1010 のデフォルト設定
	Firepower 1100 のデフォルト設定
	Cisco Secure Firewall 1210/1220 のデフォルト設定
	Cisco Secure Firewall 3100 デフォルト設定
	Cisco Secure Firewall 4200 のデフォルト設定
	Firepower 4100/9300 シャーシ デフォルト設定
	ISA 3000 のデフォルト設定
	ASA 仮想 による展開の設定

	設定の開始
	ASDM でのコマンドライン インターフェイス ツールの使用
	コマンドライン インターフェイス ツールの使用
	ASDM によって無視されるコマンドのデバイス上での表示

	接続の設定変更の適用


